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 HOW TO USE THE ANYLOGISTIX 
SOFTWARE 

A CASE STUDY USING MYDREAMZCLOSET.COM  

INTRODUCTION  

✓ AnyLogistix (ALX - www.AnyLogistix.com) is a supply chain analytics software.  

✓ This tutorial seeks to train end-users (with no prior knowledge) for using the software.  

✓ MyDreamzCloset.com is used as an example, which ALX is applied.  

✓ All examples used in this tutorial are purely hypothetical and in no case enacted in real-life 
situations whatsoever.  

 

.  

 

 

 

  

http://www.anylogistix.com/
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 GETTING STARTED  

1. Go to https://www.anylogistix.com/personal-learning-edition/, download and install the ALX 
Personal Learning Edition. (PLE)1.  

 

Figure 1: ALX PLE 

2. Go to www.MyDreamzCloset.com to browse the company, which will be applied in this tutorial.  

 

Figure 2: www.MyDreamzCloset.com 

  

 
1 ALX PLE is the free version available for download.  

ALX Studio is the paid version. In this tutorial, we focus only on the PLE version. 

https://www.anylogistix.com/personal-learning-edition/
http://www.mydreamzcloset.com/
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PROBLEM STATEMENT  

Hypothetically, MyDreamzCloset.com faces these challenges: 

✓ They carry unique, luxury, pre-loved handbags.  

✓ Each handbag has only one piece in stock.  

✓ Since they are a pure E-commerce company, they do not have physical retail shops. 

✓ Their customers are scattered throughout Singapore. 

✓ Their customers can be segregated into 5 locations. 

✓ How to minimize delivery cost each time there is an order? 

✓ How to ensure high quality of service by reducing tardiness in transportation? 

 

HOW ALX HELPS 

ALX comprises of 4 parts: 

1. Greenfield Analysis (GFA) 

2. Network Optimization (NO) 

3. Simulation  

4. Transport Optimization (TO)2 (replaced with Variation) 

 

**In this tutorial, we will only go through GFA and NO. 

 

  

 
2 Transport Optimization (TO) is not available in PLE. It’s only available in the Studio (paid edition). 

Thus, we will replace this part with “Variation”. 
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PART I  

GREENFIELD ANALYSIS (GFA)  

 

Figure 3: Greenfield Analysis (GFA) (AnyLogistix 2018) 

GFA helps by: 

1. Suggesting the best locations3 to place MyDreamzCloset’s warehouses (aka 
Distribution Centers (DCs) in ALX). 

2. Suggesting the optimal number of warehouses/DCs MyDreamCloset should have 

 

  

 
3 These are not exact locations. DCs may be placed on top of a mountain or in the middle of a sea. In the later section, 

Network Optimization (NO), specific locations will be derived.  
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INPUT DATA REQUIRED FOR GFA: 

✓ Customer Name 

✓ Customer Location 

✓ Customer Demand Patterns 

✓ Product Names 

✓ Number of Stock Keeping Units (SKUs) for each Product Type 
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STEP 1 

CREATING A GFA SCENARIO 

STEP 1A  

KICKSTARTING GFA SCENARIO 

 

Figure 4: The Very First Screen 

✓ Figure 4 shows the very first screen when ALX opens. Click on New Scenario. 

 

Figure 5: Choose GDA Option 

✓ Select Greenfield Analysis.  

✓ Type the Scenario Name: MyDreamzCloset. 

✓ Leave the rest of the settings alone. Click OK  
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Alternatively, should you get lost and not get to Figure 4 and Figure 5,  

 

Figure 6: Alternative Way to Get to GFA Option 

✓ Click on File → Select Project4 

✓ Click on Create → MyDreamzCloset → OK 

 

Figure 7: Choosing GFA Option as usual 

✓ Thereafter, repeat the steps above to get to the GFA Option. 

 
4 ALX automatically saves your work in Projects (while the term “Scenario” refers to GFA/NO/SIM/Variation). Thus, if 

you exit ALX, just click File → Select Project → MyDreamzCloset → OK. This will bring all your previous work back. 
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Figure 8 shows the GFA starting screen. 

 

Figure 8: GFA Starting Screen 

✓ Use the keyboard Ctrl button + Scroll on mouse to navigate yourself on the map until 
you zoom into Singapore. 

 

Figure 9: Zoom the Map to locate Singapore 
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STEP 1B (I)  

NAMING CUSTOMERS AND SPECIFYING THEIR LOCATIONS (MANUAL INPUT) 

 

MyDreamzCloset has 5 customers that handbags need to be delivered to: 

Table 1: MyDreamzCloset Customers 

Customer 
Name 

Customer 
Location 

Customer 
Address 

Region Latitude Longitude 

Alicia 
Jurong 
Point 

1 Jurong West 
Central 2 
S(648886) 

West 1.3400 103.7061 

Belinda 
Causeway 

Point 
1 Woodlands 

Square 
S(738099) 

North 1.4360 103.7860 

Charlotte 
Toa Payoh 
HDB Hub 

480 Lorong 6 
Toa Payoh 
S(310480) 

Central 1.3320 103.8494 

Diana 
Sentosa 
Cove 

1 Cove 
Avenue 

S(098537) 
South 1.2448 103.8411 

Eve 
Tampines 

Mall 
4 Tampines 

Central 5 
S(529510) 

East 1.3525 103.9447 

 

  



13 | P A G E  

COPYRIGHTED BY DR ALVIN ANG 

WWW.ALVINANG.SG 

This logo  represents adding customers on the map. Referring to Figure 10, 

1. Click on this logo  

2. Since we know the locations of the customers, we double click the map and give a rough 
placement for the 5 of them. 

3. We give names to the 5 customers.  

4. You should be able to see their “Location Name” (under the Location Column) change. 

 

Figure 10: Rough Placement of Customers 
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5. Click on “All” tab5. 

6. Click on Locations. 

7. Key in individually the Latitude and Longitude for each customer presented in Table 1.   

8. Ensure that the “Autofill Coordinates”6 are off.  

9. You will see the logos readjusting itself to the specific location 

 
Figure 11: Specifying Customers Latitude and Longitude 

  

 
5 The “All” tab shows all the relevant inputs for the GFA experiment – in order for ALX to calculate the optimal locations 
later. 

6 If “Autofill Coordinates” are toggled on, Latitude and Longitude are filled automatically when Name and Country are 

provided. The toggle button will be deactivated if you manually edit the Latitude or Longitude values. 
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STEP 1B (II)  

NAMING CUSTOMERS AND SPECIFYING THEIR LOCATIONS (AUTOMATIC INPUT USING 

EXCEL) 

✓ Rather than keying in Customers one by one, presume we have an Excel spreadsheet that 
contains all the customers (shown in Figure 12 below). 

 

Figure 12: MyDreamzCloset Customer Database Excel Spreadsheet  (Customer Tab) 

✓ To keep it simple, presume there are only 2 Tabs in the Customer Database Excel 
Spreadsheet: Customers and Locations. 

✓ Note that the Excel Column Headings should correspond sequentially to the ALX Column 
Heading that we are going to import. 
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✓ However, recently ALX updated its PLC version to 2.9.1.2019 version.  

✓ Thus there’s some glitches in importing.  

 

Figure 13: MyDreamzCloset Customer Database Spreadsheet (Locations Tab)  

 

✓ Note that in Figure 13, for the Locations Tab, the Excel Column Headings do not 
correspond sequentially to ALX Column Headings (due to the recent version upgrade). By 
right, they should. 

✓ However the importing should still go through smoothly 
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Figure 14: ALX GFA Import Scenario 

 

✓ Go to ALX, Figure 14, ensure that its at the “GFA – MyDreamzCloset” Scenario 

✓ Click on “Import Scenario”. 
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Figure 15: Importing Excel Customers into ALX 

✓ You will come to Figure 15 

1. Navigate to the Excel File 

2. Click on “Advanced Options” 

3. Import the 2 sheets: Customers and Locations (when you click on the down arrow, 
you will be able to tick the checkboxes. Select “Customers” and “Locations”). 

4. Un-toggle “Create New Scenario” (you will see that the “New Scenario Name” row 
greys out). 

5. Select the “MyDreamzCloset” Scenario. This ensures that the two sheets are 
imported only into the current scenario i.e. MyDreamzCloset. 

6. Un-toggle “Import Experiments”. (In a full fledge Excel Spreadsheet, there will not 
only be 2 tabs… there will be many tabs….see Figure 16… and there be a few 
“Experiment Tabs” at the end… these are the Experiments that we do not wish to 
import). 

✓ Click OK. 



19 | P A G E  

COPYRIGHTED BY DR ALVIN ANG 

WWW.ALVINANG.SG 

 

Figure 16: There are many tabs in an actual importing scenario... 

 

 

Figure 17: Error Message might appear... 

✓ As mentioned previously, recently ALX updated its PLC version to 2.9.1.2019 version.  

✓ Figure 17 error message might appear….click OK. 
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Figure 18: Not Everything Gets Imported Properly....  

✓ Since the Excel Spreadsheet cannot be imported properly, you need to “select the locations” 
for each customer and “toggle autofill coordinates” for the Lat. And Long. to appear. 

✓ By right, these should have been imported properly without needing to toggle.  
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STEP 2 

ADDING PRODUCTS 

MyDreamzCloset only holds one unique stock per handbag.  

These 5 customers each order a handbag: 

Table 2: MyDreamzCloset Customers’ Orders 

Customer 
Name 

Customer Order 

Alicia 

 

Belinda 
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Charlotte 

 

Diana 

 

Eve 
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Figure 19: Keying in the Products under Products Tab 

✓ Go to the “Products” tab, key in the products and click in “pcs” for Units. 

✓ Should there be many products, rather than keying in 1 by 1, you can always follow Step 
1b (ii) (Naming Customers and Specifying their Locations (Automatic Input using 
Excel)) above by importing the Excel Spreadsheet. 
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STEP 3 

ADDING DEMAND 

 

Figure 20: Keying in the Demand under Demand Tab 

✓ Go to the “Demand” tab, click the down arrow and select the 

o Customers = each of them 

o Products = their individual orders 

o Demand Type = Periodic Demand 

o Parameters:  

▪ Order Interval = 30 days;  

▪ Quantity = 1  

▪ Meaning 1 bag is ordered every month.. we will explain this rationale 
later 

o Time period: All Periods 

 

 

Figure 21: Demand Types: Periodic vs Historic 

✓ There are 2 Demand Types: Periodic vs Historic.  
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✓ If we select Historic Demand… 

 

Figure 22: Historic Demand Parameters 1 

o For Figure 22, double click on “total q=0” 

 

Figure 23: Historic Demand Parameters 2 

o This will bring us to Figure 23.  

o We can “Add” every single “Date” and “Time” for each particular order that 
has occurred throughout history.  

o ALX can use these historical orders to predict the best DC locations, as well as 
the number of bags to be produced each month.  
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✓ But for this case study, we select Periodic Demand… 

 

Figure 24: Periodic Demand Parameters 

o For Figure 24, double click on “Order interval q=5, Quantity=10” 

o This will bring us to Periodic Demand Parameter settings. 

o Note that for both Order Interval (days) and Quantity, they can be classified 
into various Types: 

▪ Value 

▪ Uniform 

▪ Triangular 

▪ Exponential 

▪ Normal 

▪ Lognormal 
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o What do these mean? They are probability distributions7.  

o We will ignore them for now and simply select “Value” (which means that it’s a 
fixed value). 

o For example, in this case we select Order Interval = 30 days and Quantity = 1. 

o Means that Alice, Belinda, Charlotte, Diana and Eve each order one of those 
same type of bag every 30 days.  

o Although this contradicts the assumption that MyDreamzCloset holds 1 unique 
stock per handbag (since there’s no replenishment for the exact handbag), we 
can think of this case as Alice, Belinda, Charlotte, Diana and Eve each being a 
retail store manager located at their individual shopping centers.  

o They might be ordering the identical unique product once per month. 

 

✓ Once again, should there be many “Demand Types”, rather than keying in 1 by 1, you 
can always follow Step 1b (ii) (Naming Customers and Specifying their Locations 
(Automatic Input using Excel)) above by importing the Excel Spreadsheet. 

 

 

  

 
7 At the time of writing this tutorial, I’m also writing another manuscript on Probability Distributions. Once completed, you 

can refer to that for a clearer understanding. 
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STEP 4 

CONFIGURING AND RUNNING THE GFA EXPERIMENT 

 

Figure 25: Configuring the GFA Experiment Parameters 

1. Now that all Data has been successfully inputted, i.e. 

a. Customers and their locations + Products + Demand Information all inputted 

b. Click on the small arrow.  

c. It will turn from grey to green.  

d. And if you mouse over, it will pop up “Scenario data is consistent”. 

2. Next, click on “GFA Experiment” Tab.  

a. The right hand panel, which shows the settings for GFA experiment will 
appear. 
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Figure 26: GFA Experiment Parameters 

Referring to Figure 26: 

✓ Top left hand corner  button: clicking on it will run the GFA experiment. 

o Don’t click now.  

o We will click it only after all the parameters have been inputted. 

✓ Experiment duration – there are three options to choose from: 

o All Periods 

o Selected Periods 

o Customer Period 

o All are intuitive. The Start and End dates for the GFA Experiment can be 
specified accordingly. 
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o We select All Periods, meaning we will run the experiment for a full year of 
2019. 

✓ Number of Sites vs Service Distance 

o You can only choose either one: Number of Sites or Service Distance.  

o If Number of Sites is selected, it means you are constraining the number of 
warehouses/DCs that MyDreamzCloset can have.  

▪ GFA will then help you find the best location for each DC. 

o If Service Distance is selected, it means you are allowing ALX to decide how 
many DCs you need to have, based on the maximum allowable distance from 
the DC to the customer.  

✓ Distance step for statistics (1) 

o Difficult to explain what this means here. 

o According to ALX help file, it states “statistics will be shown for sites at every 
specified distance step.” 

o The default value is 100, which we will leave it as it is for now. 

o We will illustrate this point in the next section. 

✓ Product measurement unit 

o 5 types: pcs / m3 / ft3 / kg / lb 

o We select pcs to identify each handbag. 

✓ Distance measurement unit 

o 2 types: km / mile 

o We select km 

✓ Suppliers to sites transportation discount, % 

o Default value is 50%, which we will ignore and leave it as it is for now. 

o According to ALX help file, it states “allows you to vary transportation cost, 
which affects the resulting DC locations (The larger the discount, the further 
the DC locations from the supplier and vice versa).” 
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o : Symbol for Supplier 

o : Symbol for Site / DC / Warehouse 

o In other words, we can ignore this for now because we have not touched on 
Supplier yet.  

o Supplier symbol will be introduced in PART II: Network Optimization (NO) 
later. 

✓ New Sites Icon   

o Allows you to select your icon for DC 

✓ Pre-processor 

o According to ALX Help File “custom user-defined Java processor. If no 
custom pre-processor is provided, the Default pre-processor will be used.” 

o Just ignore it. 

✓ Post-processor 

o According to ALX Help File “custom user-defined Java processor. If no 
custom pre-processor is provided, the Default pre-processor will be used.” 

o Just ignore it. 

✓ Groups of Objects: 

o All customers: included → means that we will include all details of Alice, 
Belinda, Charlotte, Diana and Eve in the GFA experiment. 

o All sites: Not included → since we do not have any DCs yet, we de-select it.  
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CASE I: ONLY 1 WAREHOUSE / DC 

✓ Presume that MyDreamzCloset can only afford to have 1 warehouse. 

✓ Where should it be located? 

✓ GFA Parameter Settings: leave everything as per Figure 26. 

✓ Click  

 

Figure 27: Results of GFA 

✓ You should see Figure 27 after clicking the play button. 

1. Right Click on “Result”. 

2. Click on “Rename” and rename it to “Only 1 Warehouse”.  

3. You will also see a red DC appearing.  

a. That is the optimal location that ALX has defined for MyDreamzCloset 
warehouse. 
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4. “Only 1 Warehouse” GFA results are shown here. 

5. Clicking on this will show the “Product Flows between Supplier and DCs and 
Customers”.  

a. But we will ignore this for now since there’s not much flows.  

6. Click on the filter button. 

 

Figure 28: What the Filter Button can do 

7. Click on the “abc” logo.  

a. You will see that the Customer Names as well as the DC Name (called 
GFA DC) has appeared next to them on the map. 

8. Click on the  logo. You will see that many straight lines appear stemming from 
the GFA DC8.   

 
8 Note that the connections are straight lines because the GFA does not consider actual roads for now. Later in NO, they 
will show the actual roads.  
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Case I: Product Flows 

 

Figure 29: Product Flows GFA Result 

✓ Figure 29 shows the Product Flows GFA Result. 

✓ It shows the various product flowing from the GFA DC to individual customers and the 
period for the GFA experiment.  

✓ How is the “Flow, pcs” column attained? 

o Since the Demand Setting was: 1 bag ordered every 30 days 

o 365 days (1 year) / 30 days = 12.17 bags. 

o Which means in 1 year, each customer ordered 12.17 bags on average. 

✓ “Distance, km” represents how far the GFA DC is from the customer. 

✓ “Flow Cost Estimation, pcs*km” represents the “Cost” of “Flow”… where the longer 
the transportation distance &/or the more number of bags being transported will 
increase this “Flow Cost”. 

✓ The smaller the “Flow Cost” the better.   
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Case I: New Site Locations 

 

Figure 30: New Site Locations GFA Result 

✓ Figure 30 shows the New Site Location.  

✓ Which is, the Latitude and Longitude for the new GFA DC.  
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Case I: Demand Coverage by Distance 

 

Figure 31: Demand Coverage by Distance (100km) GFA Result 

✓ Recall “Distance step for statistics (1)” on Page 30? 

✓ Referring to Figure 26, this “Distance Step for Statistics” was input as 100km. 

✓ Referring to Figure 31, you will realize that there are only “2 steps”: 0 km and 100 km.  

✓ This means that GFA Result will give an output for every step (=100km) 

 

Figure 32: Changing the Distance Step for Statistics  

✓ Presume now (Figure 32) we changed the “Distance Step for Statistics” to every 1 km 

for the GFA Experiment. Then we clicked . 
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Figure 33: Demand Coverage by Distance (1km) GFA Result  

✓ Figure 44 shows the Demand Coverage by Distance for every 1 km now. 

✓ In other words, this is how the “Demand, pcs” column works:  

o Alice will order = 365 days per year / 30 days per bag = 12.17 bags per year, 

o Belinda will order 12.17 bags per year likewise,  

o Charlotte = 12.17 bags per year,  

o Diana = 12.17 bags per year and  

o Eve = 12.17 bags per year 

o Total = 60.83 bags per year 

✓ For every 1 km away from the GFA DC, a corresponding demand is noted.  

o The first 12.17 bags should be delivered to Charlotte, since she lives closest to 
the DC. 

o Subsequently, at 10 km radius away from the DC, the next customer should be 
Eve, since Tampines may be the next closest to the DC.  

o This continues until 100% of all demand is satisfied by 16 km.  
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o In other words, it takes about 16 km radius from the DC to deliver all bags to 
all customers.  

 

 

Figure 34: Top Right Hand Corner Symbols 

 

✓ Figure 34 shows the top right hand corner symbols. 

✓ These are intuitive and can be explored without the need for explanation. 
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Case I: Distance Coverage by Demand 

 

Figure 35: Distance Coverage by Demand for GFA Results  

✓ Figure 35 shows the “Distance Coverage by Demand”. 

✓ This is simply another way of visualizing Figure 33. 

✓ It shows that through every 10% increase in demand, the relative distance required to 
travel from the DC to the customer. 

✓ It’s easier to understand “Demand Coverage by Distance” (Figure 33) since you can 
picturize a circular radius expanding around the GFA DC, growing km by km. 

✓ It’s not so easy to understand “Distance Coverage by Demand” (Figure 35), thus we can 
ignore it.     
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CASE II: 3 WAREHOUSES / DCS 

✓ Presume that MyDreamzCloset now can afford to have 3 warehouses. 

✓ Where should they be located? 

 

Figure 36: Change the GFA Parameter Settings 

✓ GFA Parameter Settings: change the “Number of sites” to 3 as in Figure 36. 

✓ Leave the rest of the settings as per Figure 36. 

✓ Click   
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Figure 37: Case 2 with 3 DCs 

✓ Figure 37 shows Case 2 with three DCs, results of the GFA Experiment. 

• Rename it to “3 DCs”. 

• You will notice that the experiment GFA produced 3 warehouses located 
nearest to the 5 customers.  

• Click the “filter”, “abc” and “square” symbols to see the connecting lines 
between the customers and the new DCs. 

▪ The new warehouses are labelled as:  

▪ GFA DC, GFA DC 2 and GFA DC 3. 

• Click on “Product Flows” 

• Compare each customers’ “Flow Cost Estimation” to that of Figure 29.  

▪ All has reduced greatly.  
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▪ Eve’s flow cost has reduced to zero because the warehouse is located 
so near her.   
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Case II: New Site Locations 

 

Figure 38: Case 2 New Site Locations 

 

✓ Figure 38 shows Case 2 New Site Locations. 

✓ The three new GFA DCs Latitude and Longitude are shown.   
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Case II: Demand Coverage by Distance  

 

Figure 39: Case 2 Demand Coverage by Distance (1km) GFA Result  

✓ Figure 39 shows the Demand Coverage by Distance for every 1 km from each GFA 
DC. 

✓ It shows: 

o GFA DC satisfying both Alice (12.17 bags/year) and Belinda (12.17 bags/year); 
both at 8 km away from GFA DC. 

o GFA DC2 satisfying both Charlotte and Diana; both at 5 km away from GFA 
DC2.  

o GFA DC3 serving Eve; at 0 km away from GFA DC3.  
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Case II: Distance Coverage by Demand  

 

Figure 40: Case 2 Distance Coverage by Demand GFA Result  

✓ Figure 40 shows the Distance Coverage by Demand. 

✓ Since it does not make much sense, we ignore it. 
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CASE III: SERVICE DISTANCE 6 KM 

✓ Presume that MyDreamzCloset’s customers require their warehouse to be no more than 
6 km from their house. 

✓ Where and how many DCs should they have? 

 

Figure 41: Change the GFA Parameter Settings 

✓ GFA Parameter Settings: change the “Service Distance” to 6 as in Figure 41. 

✓ Leave the rest of the settings as per Figure 41. 

✓ Click   
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Figure 42: Case 3 with 4 DCs 

✓ Figure 42 shows Case 3 with four DCs, the result of the GFA Experiment. 

• Rename it to “At Most 6 km Away from DCs”. 

• You will notice that the experiment GFA produced 4 warehouses located 
nearest to the 5 customers.  

• Click the “filter”, “abc” and “square” symbols to see the connecting lines 
between the customers and the new DCs. 

▪ The new warehouses are labelled as:  

▪ GFA DC, 2, 3 and 4. 

• Click on “Product Flows” 

• Compare each customers’ “Flow Cost Estimation” to that of Figure 37.  

▪ All has almost reduced to zero.  

▪ Reason is because it now has 4 DCs compared to 3 (in Case II).   
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Case III: New Site Locations 

 

Figure 43: Case 3 New Site Locations 

 

✓ Figure 43 shows Case 3 New Site Locations. 

✓ The three new GFA DCs Latitude and Longitude are shown. 

✓ Regarding “Distance Coverage by Demand” and “Demand Coverage by Distance”, we 
shall ignore. This is because their results will not make much sense here.   
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PART II  

NETWORK OPTIMIZATION (NO)  

 

Figure 44: Network Optimization (NO) (AnyLogistix 2018) 

NO helps by: 

1. Specifying the exact locations for placing warehouses/DCs. 

2. Specifying the location/s of suppliers.  

a. Suppliers are the source from which DCs obtain the goods. In other words, 

Supplier → DCs → Customers.  

b. Referring to Figure 44, “Product Sourcing” means “where the products are 
coming from”, referring to the specific location of the Supplier. 

3. Suggesting actual and best transportation routes. 

a. ALX will use its “Inventory Policy” (Figure 44) to decide optimal transportation 
routes. 

b. “Inventory Policy” refers to parameter inputs that can be configured, such as 
transportation costs and storage policies. 
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INPUT DATA REQUIRED FOR NETWORK OPTIMIZATION (NO): 

✓ Previous GFA Parameters and Scenario 

✓ Supplier Location 

✓ Practical Knowledge of Land Parcels/Warehousing Space for Sale (in order to 
suggest feasible warehouse locations) 
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STEP 1 

CONFIGURE AND RUN THE NO EXPERIMENT 

STEP 1A  

CONVERTING THE GFA TO NO 

 

Figure 45: Converting GFA to NO 

✓ Figure 45 shows how we convert GFA to NO. 

✓ This step is important because we are transferring all Data from GFA scenario into NO 
scenario for further analysis.  

• Under the GFA Tab, 

• Right click on “Case II: 3 DCs”. 

• Select “Convert to NO Scenario”.  
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STEP 1B  

SPECIFYING EXACT LOCATIONS OF DCS 

 

Figure 46: NO Data Input 

✓ Figure 46 shows the NO Data input screen right after GFA has been converted to NO. 

✓ We will not run the NO experiment yet because there are a few things we need to do 
first: 

• Click the tick and watch it turn green, meaning that the “Scenario Data is 
Consistent”. 

• We will need to rename “GFA DC 3” to “The East Warehouse”. 

▪ Currently, its location is directly at Tampines Mall (at where Eve lives). 

▪ MyDreamzCloset management wants to relocate it. 

• We will need to rename “GFA DC 2” to “The South Warehouse”. 

▪ Currently, its location is at Clarke Quay. 

▪ MyDreamzCloset is considering shifting it to other areas within its 
vicinity. 

• We will need to rename “GFA DC 3” to “The West Warehouse”. 

▪ Currently, its location is at North Vale Condominium at Choa Chu 
Kang. 
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▪ MyDreamzCloset is considering shifting it to other areas within its 
vicinity. 

 

GFA DC 3: The East Warehouse 

 

Figure 47: Renaming GFA DC 3 to The East Warehouse 

✓ Figure 47 shows how to rename “GFA DC 3” to “The East Warehouse”. 

✓ Click on “All” Tab. 

✓ Click on “DCs and Factories”. 

✓ Double Click on “GFA DC 3” and rename it to “The East Warehouse”. 
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Figure 48: Adjusting the Location of the East Warehouse 

✓ Figure 48 shows the new location of The East Warehouse = Citylife at Tampines. 

✓ Currently, ALX suggested the warehouse location to be Tampines Mall but rental is too 
costly. 

✓ The new location will be shifted to Citylife at Tampines (a residential area) because one 
of the staff is working from home and willing to house the stock. 
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Figure 49: Drag and Drop and Watch the Lat Long Change 

 

✓ Figure 49 shows how to change the location of The East Warehouse. 

✓ Simply drag and drop the icon  to Citylife at Tampines. 

✓ Next, go to “Locations” tab and observe how the Latitude and Longitude changes.   
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GFA DC 2: The South Warehouse 

✓ Follow Figure 47 to rename “GFA DC 2” to “The South Warehouse”. 

 

Figure 50: Possible Locations for the South Warehouse 

✓ Currently, the proposed location by ALX is Clarke Quay. 

✓ Clarke Quay is better known to be a “drinking place” where pubs are located.  

✓ MyDreamzCloset management thinks it’s inappropriate to have a warehouse there and is 
considering 4 other options within its vicinity, namely: 



57 | P A G E  

COPYRIGHTED BY DR ALVIN ANG 

WWW.ALVINANG.SG 

• Riverside Point 

• Bras Basah Complex 

• Suntec City 

• Marina Bay Sands 

 
Creating an Optional Warehouse at Riverside Point  

 

 

Figure 51: Creating an Optional Warehouse at Riverside Point 

✓ Figure 51 shows how to create an optional warehouse at Riverside Point. 

✓ Notice that The South Warehouse logo still remains at the original position as proposed 
by ALX.  

1. Right click on the Riverside Point building on the map. 

2. Select “Create Warehouse”. 
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Figure 52: Renaming the Riverside Point Warehouse 

✓ Figure 52 shows that a new DC logo has appeared at Riverside Point. 

✓ Rename it to “South 1 – Riverside Point” – which means “Option 1 for the South 
Warehouse at Riverside Point”. 

✓ Repeat the steps from Figure 51 onwards for creating optional warehouses at Bras Basah 
Complex, Suntec City and Marina Bay Sands.  
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Figure 53: The 4 Optional South Warehouses 

✓ Figure 53 shows the 4 optional warehouses created that will be considered later for the 
south side. 
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GFA DC 1: The West Warehouse 

 

Figure 54: Options for the West Warehouse 

✓ Currently, the proposed location by ALX for the West Warehouse is at North Vale 
Condominium at Choa Chu Kang. 

✓ It’s impossible to have a warehouse there.  

✓ MyDreamzCloset management is considering 2 other options within its vicinity, namely: 

• Lot One Shopping Mall 

• Ten Mile Junction Shopping Mall 

✓ Repeat the steps from Figure 51 onwards to create optional warehouses at Lot One and 
Ten Mile Junction.  
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Figure 55: Creating the optional warehouses for the West side  

 

✓ Figure 55 shows the 2 optional warehouses being created and renamed.  
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STEP 1C  

SELECTING WHICH DCS TO INCLUDE/EXCLUDE/CONSIDER 

 

 

Figure 56: Which DCs to Include / Exclude / Consider? 

✓ Figure 56 shows 3 clusters of DCs: West, South and East.  

✓ We will decide which DCs we want to include / exclude / consider for the NO 
experiment. 

1. The West Warehouse (proposed by ALX): Exclude 

a. Reason: As mentioned earlier, it is situated at Northvale Condominium 
which is impossible to house the stock. 

2. The South Warehouse (proposed by ALX): Exclude 
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a. Reason: As mentioned earlier, it is situated at Clarke Quay where it’s a night 
spot. MyDreamzCloset management doesn’t like its location.  

3. The East Warehouse (proposed by ALX): Include 

a. Reason: As mentioned earlier, it is situated at Tampines Mall, but we have 
shifted its location to Citylife at Tampines. 

b. There’s only one East Warehouse and MyDreamzCloset management has 
decided that it should be located at Citylife.  

4. For South1: Riverside Point all the way to West 2: Ten Mile Junction, we will select 
“Consider” because we are still unsure of which options to choose. 
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STEP 1D  

GROUPING THE DCS  

 

Figure 57: Groups 

✓ Figure 57 shows the various groups created by ALX initially. 

✓ GFA Group consists of the 3 initial proposed DCs by ALX: West, South and East 
Warehouses. 

✓ GFA Group 2 consists of all the customers.  

 

Figure 58: Renaming and Creating New Groups 

✓ Figure 58 shows how to rename and create new groups 



65 | P A G E  

COPYRIGHTED BY DR ALVIN ANG 

WWW.ALVINANG.SG 

a. Rename “GFA Group” to “ALX DC Group” to represent the initial DCs that 
ALX proposed. 

▪ Rename “GFA Group 2” to “All Customers Group” to represent a 
group representing all customers. 

▪ Click “Add” to create “West Side DC Group”, “South Side DC 
Group” and “East Side DC Group” 

b. Double click the “Sites” 

c. A pop up will show the DCs that you wish to include in the group. Include 
them accordingly.  

 

Figure 59: Final DC Groups 

✓ Figure 59 shows the final DC groups after creating them.  
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STEP 1E  

ADDITIONAL CONSTRAINTS FOR CHOOSING DCS  

 

 

Figure 60: Configuring the Assets Constraints 

✓ Figure 60 shows how to ensure that NO experiment will only pick 1 DC from each 
group. 

✓ Not forgetting that MyDreamzCloset can only afford to have 3 DCs in Singapore (refer 
to Case II: 3 Warehouses / DCs), we need to make sure that ALX will only choose 

• 1 DC from “East Side DC Group” 

• 1 DC from “South Side DC Group” 

• 1 DC from “West Side DC Group”. 

✓ This is achieved by setting “Min = 1” and “Max = 1”. 
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STEP 1F  

SPECIFYING LOCATION FOR THE SUPPLIER  

 

Figure 61: Creating a Supplier 

✓ MyDreamzCloset get their stock from Paya Lebar Square. 

✓ The Latitude and Longitude coordinates for Paya Lebar Square is 1.3192° N, 103.8926° 
E. 

✓ You can create the “Supplier” icon on the map by either: 

a. Search for the location of Paya Lebar Square on the map (Figure 61), right click 
and select “Create Supplier”  

or 

b. Go to “All → Suppliers → Add and Create a Supplier first → Locations → 
Input the Latitude and Longitude of Paya Lebar Square for the supplier”. 

✓ Referring to Figure 61, go to the “Suppliers” tab and rename the “Supplier” name to 
“MyDreamzCloset Supplier”.  
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STEP 1G  

DEFINING HOW THE PRODUCTS FLOW  
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STEP 1H  

CONFIGURING THE STORAGE POLICY  
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STEP 1I  

SETTING THE TRANSPORTATION COSTS  
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STEP 1J  

RUNNING THE NO  
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ABOUT  

ABOUT THE ANYLOGISTIX SOFTWARE 

AnyLogistix™ (ALX™) by The AnyLogic Company is a supply chain analytics software for 

designing, optimizing and analyzing companies’ supply chain. ALX combines powerful analytical 

optimization approaches together with innovative dynamic simulation technologies to offer a 

comprehensive set of tools for end-to-end supply chain analytics. By leveraging both simulation and 

optimization, it provides deep insights, which is not currently possible with traditional solutions. 

More about AnyLogistix at www.AnyLogistix.com.  

 
ABOUT MYDREAMZCLOSET.COM 

MyDreamzCloset.com is a pre-loved, authentic luxury handbag E-boutique which started in 

2010. They sell high end handbags for ladies, which comprise of brands such as Chanel, Christian 

Dior and Versace. As they are a pure E-commerce company, they have no physical retail outlets. You 

can find out more about MyDreamzCloset at www.MyDreamzCloset.com.  

 
ABOUT DR. ALVIN ANG 

 

Dr. Alvin Ang did his Ph.D., Masters and Bachelor degrees from NTU, Singapore He is a 

business consultant, scientist as well as a lecturer. You can find out more about him at his website 

www.AlvinAng.sg.   

 

http://www.anylogistix.com/
http://www.mydreamzcloset.com/
http://www.alvinang.sg/

